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ABSTRAK 

 
Daerah penelitian yang terletak di Desa Karangmojo dan sekitarnya, Kecamatan 

Karanggayam, Kabupaten Kebumen, Provinsi Jawa Tengah. Daerah penelitian yang secara 
fisiografi termasuk kedalam zona pegunungan serayu selatan (van Bemmelen, 1949). Secara 
stratigrafi daerah penelitian terbagi menjadi enam satuan antara lain yaitu satuan Rijang, satuan 
batuan batulempung karbonatan Karangsambung, satuan batuan breksi polemik Totogan, satuan 
batuan breksi andesit Waturanda, satuan batuan batupasir karbonatan Penosogan dan satuan batuan 
batupasir karbonatan Halang. Umur batuan tertua sampai termuda pada kala Paleosen sampai 
Miosen Akhir. Daerah penelitian terbagi dalam tiga satuan geomorfologi yaitu satuan perbukitan 
dan lereng landai-curam menengah denudasional (D1), satuan pegunungan dan perbukitan 
denudasional (D2) dan satuan perbukitan antiklin dan sinklin structural (S9).  Daerah penelitian 
memiliki potensi batupasir sebagai batuan yang dapat menyimpan dan mengalirkan air (akuifer), 
sehingga dapat dimanfaatkan masyarakat setempat untuk penunjang kebutuhan air bawah 
permukaan. 
Kata kunci : Geologi, Stratigrafi, Geomorfologi, Akuifer. 

 
ABSTRACT 

 
The research area is located in Karangmojo Village and its surroundings, Karanggayam 

District, Kebumen Regency, Central Java Province. The research area is physiographically 
included in the southern Serayu mountain zone (van Bemmelen, 1949). Stratigraphically, the 
research area is divided into six units, namely the Chert unit, the Karangsambung carbonate 
mudstone rock unit, the Totogan polemic breccia rock unit, the Waturanda andesite breccia rock 
unit, the Penosogan carbonate sandstone rock unit and the Halang carbonate sandstone rock unit. 
The ages of the oldest to youngest rocks are Paleocene to Late Miocene. The research area is 
divided into three geomorphological units, namely the denudational hills and medium-steep slopes 
unit (D1), the denudational mountains and hillsides unit (D2) and the structural anticline and 
syncline hills unit (S9). The research area has the potential for sandstone as a rock that can store 
and channel water (aquifer), so that it can be used by local communities to support subsurface 
water needs. 
Keywords: Geology, Stratigraphy, Geomorphology, Aquifer. 
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1. PENDAHULUAN 
 

Daerah penelitian terletak di Desa Karangmojo dan sekitarnya, Kecamatan Karanggayam, 
Kabupaten Kebumen, Provinsi Jawa Tengah. Secara fisiografi termasuk kedalam Zona Pegunungan 
Serayu selatan (Van Bemmelen, 1949) yang telah dipetakan oleh Asikin, dkk (1992). Secara detail 
daerah ini belum pernah dilakukan penelitian geologi sehingga menarik untuk penulis meneliti 
lebih lanjut mengenai “Geologi dan porositas satuan batupasir karbonatan Halang sebagai akuifer 
Daerah Karangmojo dan sekitarnya Kecamatan Karanggayam, Kabupaten Kebumen, Provinsi Jawa 
Tengah”. Sumberdaya pada daerah penelitian sendiri sangatlah beragam salah satunya batupasir 
merupakan bagian dari batuan sedimen klastik yang memiliki porositas cukup baik. Porositas 
sendiri merupakan variabel utama dalam penentuan besaran cadangan fluida pada suatu massa 
batuan. Menurut Todd (1959) batupasir memiliki nilai porositas 30-40% umumnya berperan 
sebagai reservoir atau akuifer. Ukuran porositas pada batupasir ditentukan oleh butir serta 
distribusinya, derajat pemilahan (sortation), bentuk butir, kebundaran (roundness), susunan antar 
butir, kompaksi dan sementasi. Berdasarkan hal tersebut penyusun melatar belakangi penelitian 
terhadap porositas batupasir Formasi Halang untuk mengetahui nilai persentase dari porositas 
batupasir menggunakan sayatan petrografi dengan cairan Blue Dye. Harapan penelitian ini mampu 
memberikan informasi yang berguna bagi kemajuan pengembangan daerah sekitar sebagai data 
acuan awal untuk pengairan.  

 
2. METODE PENELITIAN 

 
Metode yang digunakan untuk menyelesaikan permasalahan geologi di daerah penelitian 

metode pemetaan geologi permukaan (geological surface mapping). Metode ini mempunyai sistem 
yang meliputi pengamatan, pemerian, pengukuran data geologi yang tersingkap di permukaan 
bumi, baik berupa data singkapan batuan, morfologi, struktur geologi, potensi sumber daya geologi 
dan potensi bencana geologi. Masing-masing tahap penelitian tersebut dijelaskan sebagai berikut: 

 

 
Gambar 1. Diagram skema alur penelitian  

 
2.1 Pemerian dan Pengukuran Aspek Geologi 
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Pemerian aspek geologi meliputi ciri fisik batuan dan kaitannya dengan morfologi, 
stratigrafi, struktur geologi, sejarah geologi serta geologi lingkungan, potensi sumber daya geologi 
serta arah gerakan tanah dan luas wilayah dampak gerakan tanah tersebut. Pemerian batuan di 
lapangan yang dilakukan menyesuaikan seperti penarikan penamaan yang sesuai dengan kriteria 
ciri-ciri megaskopis batuan yang ada di lapangan. Deskripsi litologi secara megaskopis mengacu 
pada 2 klasifikasi yang berbeda yakni  
a. klasifikasi (O’Dunn & Sill, 1986) Klasifikasi tersebut membagi batuan beku berdasarkan jenis 

Batuan Beku Plutonik dan Vulkanik menurut persentase kandungan mineral mafik dan felsik 
serta persentase dari mineral tersebut. (Tabel 1)  

 
Tabel 1. Klasifikasi penamaan batuan beku berdasarkan   tekstur dan komposisi mineral 

penyusun batuan. (O’Dunn & Sill, 1986) 
 

 
 

b. klasifikasi (Wentworth, 1922), klasifikasi ini didasarkan atas perbedaan ukuran butir dalam 
suatu batuan sedimen. (Tabel 2) 

 
Tabel 2. Klasifikasi penamaan batuan sedimen klastik berdasarkan  ukuran  butir. (Wentworth, 

1922) 
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2.1.1  Pengamatan Petrografi 

Analisis ini bertujuan untuk mendapatkan data berupa komposisi, ciri dan sifat optik batuan 
secara mikroskopis berdasarkan kenampakan mikroskopisnya dimana menggunakan sayatan tipis 
batuan dengan perbesar 4x yang telah dipreparasi dan dianggap telah mewakili batuan yang ada. 
Klasifikasi batuan yang digunakan dalam pengamatan mikroskopis yaitu mengacu pada 5 
klasifikasi yang berbeda yakni (Pettijohn, 1975) klasifikasi tersebut membagi batuan sedimen 
klastik dan sedimen non-klastika berdasarkan kuarsa, feldspar dan lithic fragments. (Gambar 2) 

 

 
 

Gambar 2. Klasifikasi Batupasir berdasarkan komposisi kuarsa, feldspar dan 
fragmen dalam suatu tubuh batuan. (Pettijohn, 1975) 

 
Klasifikasi (Dunham, 1962), klasifikasi ini membagi batuan sedimen karbonat berdasarkan 

tekstur pengendapannya yang mengacu pada hubungan antar butir batuan seperti yang tertera di 
klasifikasi. (Tabel 3) 

 
Tabel 3. Klasifikasi (Dunham, 1962) 
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Gambar 3. Klasifikasi batuan beku berdasarkan kandungan mineral kuarsa, plagioklas dan alkali 
feldspar dalam suatu tubuh batuan. (Steckeisen, 1976) 

 

 
 

Gambar 4. Klasifikasi QAPF untuk batuan vulkanik berdasarkan  kandungan Q = kuarsa, A = 
Alkali feldspar, Plagioklas dan F = Felsdpatoid. (Streckeisen, 1978) 
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Gambar 5. Klasifikasi ini membagi batuan sedimen karbonat berdasarkan komposisi sand, 
allochems, mud dan micrite dalam suatu tubuh batuan. (Mount, 1985) 

 

 
 

Gambar 6. Klasifikasi batuan sedimen berdasarkan komposisi clay, sand dan silit dalam suatu 
tubuh batuan menurut. (Shepard, 1954) 

 
2.1.2 Pengamatan Mikropaleontologi 

Pekerjaan ini dilakukan untuk penentuan umur dengan menggunakan zonasi fosil indeks 
menurut Blow (1969) dan penentuan lingkungan pengendapan menggunakan klasifikasi menurut 
Tipsword (1966) (Gambar. 7). Penentuan sampel batuan untuk dilakukan analisis perlu 
memperhatikan zona bagian bawah, zona bagian tengah dan zona bagian atas dari setiap satuan 
batuan, dalam penentuan setiap zona dapat didasarkan arah kemiringan batuan sehingga dalam 
pengambilan sampel batuan harus mengikuti arah kemiringan batuan (dip) hingga di batas atau 
diujung sebaran batuan tersebut. 
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Gambar 7. Lingkungan pengendapan. (Tipsword, 1966) 
 
2.2.    Pekerjaan Software ImageJ 

Pekerjaan ini merupakan tahapan yang dilakukan dengan menganalisis gambar mikroskop, 
pengukuran area, perhitungan partikel, segmentasi dan pengukuran fitur spasial dan temporal dari 
elemen biologis.  

Dalam perhitungan porositas menggunakan perangkat lunak ImageJ, terdapat beberapa 
langkah yang perlu dilakukan yaitu: 
Mengatur skala pengukuran yang digunakan dalam perangkat lunak ImageJ, dimana perangkat 
lunak ImageJ yang menggunakan skala dasar berupa pixel perlu diubah menjadi skala mm yang 
disesuaikan dengan kebutuhan (Langkah : Buat garis lurus pada gambar > Analyze > Set scale). 
(Gambar 8)  
 

 
 

Gambar 8. Tahap mengubah skala dari pixel menjadi mm pada menu (set scale) 
 

(Langkah memotong gambar : Image > Crop > Edit > Invert). (Gambar 9)  
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Gambar 9. Tahap memotong gambar untuk mengubah gambar menjadi persegi 
 

Kemudian langkah selanjutnya mengatur tipe gambar menjadi 8-bit. (Langkah : Image > type > 
8-bit). (Gambar 10) 
 

 
 

Gambar 10. Tahap mengubah gambar menjadi menjadi 8-bit untuk melihat rongga yang terisi 
cairan blue day 

 
Mengatur kontras warna gambar sayatan untuk membedakan kecerahan antara pori-pori yang terisi 
cairan Blue Dye dengan yang bukan pori-pori. (Langkah: Image > Adjust > Threshold > Apply). 
(Gambar 11) 
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Gambar 11. Gambar berubah menjadi hitam-putih pada tahap ini area yang terisi cairan blue day 
ditandai berwarna putih 

 
Perhitungan persen area dimana hasil akhir dari perhitungan ini merupakan nilai dari porositas 
sampel batuan tersebut. (Langkah: Analyze > Set Measurements ; Analyze > Analyze Particles). 
(Gambar 12) 

 

 
 

Gambar 12. Hasil akhir perhitungan rongga Analyze Partikel 
 

2.3    Peralatan yang digunakan 
Peralatan yang akan digunakan pada penelitian ini meliputi peralatan untuk penelitian 

lapangan, laboratorium dan studio. Peralatan yang digunakan untuk mendukung kelancaran dalam 
pekerjaan di lapangan meliputi: 
1. Peta Rupa Bumi Indonesia (BAKOSURTANAL) Lembar Gembong 1408-133 
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2. Peta topografi skala 1:25.000 X: 346800–340800 E, Y: 9168000–9159000 S 
3. Peta Geologi Regional lembar Kebumen dengan skala 1: 100.000  
4. Peta rencana lintasan  
5. Sayatan tipis porositas menggunakan cairan blue day 
6. Kompas geologi, Global Positioning System (GPS), Aplikasi Avenza Maps, palu geologi, kaca 

pembesar (loupe), larutan asam klorida (HCl), pita ukur (rollmeter), kamera (Handphone), 
plastik sampel batuan, alat tulis, buku lapangan, peralatan keamanan lapangan (jas hujan, topi 
dan sarung tangan). 

 
3. HASIL DAN PEMBAHASAN 

 
3.1     Analisis petrografi dan perhitungan nilai porositas menggunakan ImageJ 

Berdasarkan analisis petrografi dan perhitungan nilai porositas menggunakan software 
Image-J terhadap batupasir diketahui penyebaran pori-pori porositas asalnya dalam ketiga  tubuh 
sampel porositas batupasir menggunakan cairan blue dye, maka didapatkan  hasil analisis. (Tabel 
5.1) dan (Tabel 5.2) 

 
Tabel 4. Parameter penyusun dalam penentuan porositas 

 

NO ID SAMPEL Ukuran 
Butir (mm) 

Derajat 
Pembundaran 

Derajat 
Pemilahan Kemas 

1 Top 0,003-0,04 Subrounded Sedang Tertutup 
2 Middle 0,001-0,05 Subrounded Sedang Tertutup 
3 Bottom 0,001-0,02 Rounded Baik Tertutup 

 
 

Tabel 5. Hasil perhitungan nilai porositas 
 

Slice Count Total Area Average Size Persen Area Mean 

Top 2812 65,19 0,02 39,75 255 

Middle 2247 64,80 0,03 47,73 255 

Bottom 808 75,49 0,09 58,84 255 

 
a) Pada sampel bottom (LP 4) sayatan petrografi batupasir kenampakan penyebaran pori-pori 

dipengaruhi oleh porositas primer intergranular/ interpartikel dan porositas sekunder rekahan 
(fracture) dengan nilai persen area atau nilai porositas sebesar 58,84% . (Gambar 13) 
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Gambar 13. Hasil analisis petrografi dan perhitungan porositas sampel bottom (LP 4) 
 
b) Pada sampel middle (LP 5) sayatan petrografi batupasir kenampakan penyebaran pori-pori 

dipengaruhi oleh porositas primer intergranular/interpartikel dengan nilai persen area atau 
nilai porositas  sebesar 47,73%. (Gambar 14) 
 

 
Gambar 14. Porositas primer intergranular/interpartikel dengan nilai persen area atau nilai 

porositas  sebesar 47,73% 
 

c) Pada sampel top (LP 7) sayatan petrografi batupasir kenampakan penyebaran pori-pori 
dipengaruhi oleh porositas primer intergranular/interpartikel dengan nilai persen area atau nilai 
porositas sebesar  39,75%. (Gambar 3.3) 
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Gambar 15. Hasil analisis petrografi dan perhitungan porositas sampel top (LP 7) 
 

3.2 Pembahasan 
Hasil perhitungan nilai porositas batupasir secara kuantitatif pada ketiga sampel sayatan 

petrografi menunjukkan adanya kenaikan nilai persentase porositas secara progresif  yang 
dipengaruhi oleh salah satu parameter empiris batupasir yaitu ukuran butir, derajat pembundaran, 
sortasi dan kemas. Hasil analisis menunjukan pada sampel top memiliki nilai ukuran butir sebesar 
0,003-0,004 dengan nilai persen area porositas keseluruhan 39,75 terdiri dari porositas primer 
(intergranular), pada sampel middle memiliki nilai ukuran butir sebesar 0,001-0,05 dengan nilai 
persen area porositas keseluruhan sebesar 47,73 terdiri dari porositas primer (intergranular) dan 
sampel bottom memiliki nilai ukuran butir 0,001-0,02 dengan nilai persen area porositas 
keseluruhan 58,84 terdiri dari porositas primer (intergranular) dan sekunder (fracture). Hasil 
analisis ukuran butir menggunakan metode skala wentworth, sampel batupasir dianalisis langsung 
dilapangan (in situ). Pemilahan (sorting) adalah cara penyebaran berbagai macam besar butir. 
Dengan demikian rongga yang terdapat diantara butiran besar akan diisi butiran yang lebih kecil 
lagi sehingga porositasnya berkurang (Koesomadinata, 1978). Hal ini yang menyebabkan apabila 
nilai ukuran butir naik maka nilai porositasnya akan menurun. Serta diperkuat oleh Beard and Weyl 
(1973) menyatakan bahwa porositas sangat kecil dipengaruhi oleh perubahan dalam ukuran butir 
dengan sortasi yang sama tetapi porositas bervariasi  terhadap sortasi. Pernyataan tersebut 
didukung pula oleh Scherer (1987) yang mengatakan bahwa porositas berkurang secara progresif 
dari pasir bersortasi sangat                         baik sampai pasir yang bersortasi sangat jelek pernyataan 
tersebut dapat diartikan                 bahwa batupasir yang memiliki sortasi sangat baik akan memiliki 
nilai porositas yang tinggi dan nilai porositas tersebut akan terus menurun pada batupasir yang 
memiliki sortasi sangat jelek.  

Berdasarkan hasil dari nilai porositas yang telah didapatkan dari ketiga     sampel sayatan 
tersebut maka nilai kualitas dari ketiga sampel tersebut terhadap porositas dikategorikan termasuk 
dalam kualitas baik, karena memiliki nilai porositas > 20%. 
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4.  KESIMPULAN 
 

Berdasarkan hasil pemetaan geologi permukaan rinci pada daerah penelitian  meliputi aspek 
geomorfologi, stratigrafi, struktur geologi dan geologi lingkungan, maka dapat ditarik kesimpulan 
sebagai berikut : 

Berdasarkan perhitungan beda tinggi dan kelerengan (morfometri) Geomorfologi daerah 
penelitian terbagi atas 3 satuan yakni Satuan perbukitan dan lereng landai-curam menengah 
Denudasional (D1). Satuan pegunungan dan perbukitan Denudasional (D3) dan Satuan perbukitan 
antiklin dan sinklin Struktural (S9). Stratigrafi daerah penelitian terbagi atas 6 satuan yang terdiri 
dari tua ke muda yaitu satuan batuan rijang, satuan batuan batulempung karbonatan 
Karangsambung, satuan batuan breksi polimik Totogan, satuan batuan breksi andesit Waturanda, 
satuan batuan batupasir karbonatan Penosogan dan yang termuda satuan batuan batupasir 
karbonatan Halang. Struktur geologi daerah penelitian yang berkembang berupa lipatan antiklin 
dan sinklin hasil dari rekonstruksi strike/dip menghasilkan arah tegasan utama yakni Antiklin 
kaliguci berarah (selatan tenggara-barat laut) dan kalikayen berarah (selatan barat daya-utara). 
Sinklin Kalimrica memiliki arah tegasan utama yakni (utara-selatan tenggara). Serta dijumpai Sesar 
Kaligowok yang memiliki arah tegasan utama N24°E / 42°. Hasil dari analisis SRTM arah tegasan 
utamanya yaitu barat laut-tenggara. Revolusi sejarah geologi daerah penelitian dimulai pada kala 
Paleosen dengan diendapkannya satuan batuan tertua pada daerah penelitian yaitu satuan rijang 
dalam jangka waktu tertentu. Satuan ini mengalami fase tektonik yang mengakibatkan terjadinya 
pengangkatan dan terendapkan pada kala Eosen-Oligosen menghasilkan satuan batuan 
batulempung karbonatan Karangsambung. Kemudian pada kala Oligosen tengah-Miosen Awal 
terjadi lagi aktivitas vulkanismen yang mengakibatkan terjadinya pelongsoran material vulkanik 
dari aktivitas magma terendapkan diatas satuan batuan breksi polimik Totogan menjadi batuan 
sedimen breksi yang menunjukan perubahan dari batupasir kasar menjadi breksi andesit. Masuk 
kala miosen tengah terjadi proses pengendapan menghasilkan satuan batuan batupasir karbonatan 
Penosogan yang terangkat karena masih dipengaruhi oleh fase tektonik. Proses pengendapan 
terakhir terjadi pada kala miosen akhir terendapkan secara selaras menghasilkan satuan batuan 
batupasir karbonatan Halang. 

Berdasarkan hasil dari analisis 3 sampel sayatan menggunakan cairan blue dye untuk 
mendapatkan nilai porotisas secara kuantitatif, maka didapatkan nilai porositas sampel top 34,64%, 
sampel middle 38,89% dan sampel bottom 45,19%. Sedangkan unuk nilai kualitas dari ketiga 
sampel tersebut terhadap porositas dikategorikan termasuk dalam kualitas baik, karena memiliki 
nilai porositas >20%. Secara umum bahwasanya batupasir pada daerah penelitian dapat berperan 
sebagai lapisan pembawa air tanah atau akuifer, baik dapat sebagai akuifer bebas, akuifer tertekan, 
akuifer bocor ataupun akuifer menggantung. 
 

5. SARAN 
 

Adapun saran yang dapat diberikan dari hasil penelitian geologi ini perlunya dilakukan penelitian 
lebih lanjut dan sifatnya lebih rinci. Serta secara sistematis terutama untuk mengetahui kondisi 
umur secara absolut. Kemudian beberapa potensi geologi lingkungan daerah penelitian berupa 
akuifer, yang dimana dalam mengetahui hasil porositas harus lebih banyak lagi menggunakan data 
sebagai acuannya sehingga nantinya dapat dikembangkan untuk warga sekitar sebagai cadangan air 
untuk kebutuhan warga sebagai terasering. 
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